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Extended search

A  of this page,  on , was based off this revision.quality version approved 26 April 2021

 replaces the default MediaWiki search engine. It is based on the  ExtendedSearch Elasticsearch
engine and provides many improvements over standard MediaWiki search both in terms of 
quality of indexed content and user interface. Pages and files are indexed immediately and 
available for searching in real-time.
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1.  
2.  

Usage

Extended search offers two ways of searching for content:

Title search using the quick search
Fulltext search using the search center

By default, the search indexes:

wiki pages: all content pages, except for pages in the MediaWiki namespace
special pages: all pages in the namespace Special
repo files: files uploaded to the wiki - for text files like Word documents and PDFs, this includes content 
and metadata
external files: files from arbitrary locations from accessible storage paths (e.g., mounted drives)
social entities: entities (pages) created by the  extension, like blog posts and user profilesBlueSpiceSocial

Autocomplete

The search box in the main toolbar offers with autocomplete functionality is available from any 
page on the wiki. Autocomplete matches only page and file titles, but does not provide a full-text 
serach.

After typing in the search bar, an autocomplete popup appears:

Autocomplete popup

This popup is divided in two columns.

Left column:

Primary results: These are the results that are direct matches for the search term. The exact matches 
are shown in bold letters.

When looking for the term "quality management", it is also possible to type in "qual man" and the 

https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceSocial
https://bs3-en.wiki.bluespice.com/wiki/File:Manual:extendedsearch-autocompleteEN.png
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When looking for the term "quality management", it is also possible to type in "qual man" and the 
search starts looking for matches
The best match is often shown with a thumbnail preview as a top search result

Right column:

T  Tools are displayed in the top portion of the right column and contain:ools and secondary results:
a button to create the page with the current search term as the title (only if user has permission to 
create new pages)
a button to execute full-text search for the current term. Selecting this option leads to the Search 
Center.

In the bottom portion of the right column, secondary results are displayed. Secondary results are 
matches that do not directly match the given term, but might be relevant for the user. These 
show up only in certain contexts:

If there are significantly more matches for a similar term than the term actually searched for (in a 
situation of a typo for example)
If the namespace or subpage pill is present (see next section). In this case, secondary results will show 
direct matches in other namespaces/pages.

Namespace and subpage "pills"

Autocomplete search bar supports pills for namespaces and subpages.

Namespace "pill"

If a user types , a pill for the namespace "Manual" appears and the search for the Manual:
following term is limited to this namespace. . Subpage pills work in the same way. If the user 
types in , any term after that is matched in the context of that page. If you search for PageName/
"TestPage/Te", for example, the search will match only subpages of "TestPage" that contain "Te" 
in the title, like "TestPage/Test" and "TestPage/TestSubpage".

Configuration

Previously explained is the full version of the autocomplete popup. Wiki admins can also choose 
to use "Simple autocomplete", which contains only one column with primary results and tools, 
without secondary results. This type of autocomplete is also more compact. This setting is 
available from , under BlueSpiceConfigManager Extension > BlueSpiceExtendedSearch > Use 

.simple autocomplete

Search operators

Since the autocomplete search only searches for titles, search operators such as AND or OR are 
not supported. However, they are supported using the Search Center.

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:extendedsearch-pilleEN.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager
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Dates as search terms

The search recognizes certain date formats. In the search center, these date formats are treated 
with surrounding quotation marks.

 

Date format 1

Date format 2

Search Center (extended search)

As soon as you trigger the full-search with the magnifying glass symbol or the  key, the wiki Enter
switches to the Search Center. This is a special page that offers the full functionality of the 
search. The search in the Search Center is carried out using the same search bar that is also used 
for autocomplete.

Here, the search engine carries out a full text search, which also includes the metadata of 
documents. It does not index the wikitext of a wiki page, but rather the rendered content, that is 
the output by the browser.

https://bs3-en.wiki.bluespice.com/wiki/File:extendedsearch-datum1.png
https://bs3-en.wiki.bluespice.com/wiki/File:extendedsearch-datum2.png
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Search Center

Search operators

To use search operators in the full-text search, the following syntax can be used:

Sandbox  Widgets - returns pages that contain both the term sandbox and the term widgetsAND
Sandbox  Widgets - returns pages that contain either the term sandbox or the term widgets.OR
(Sandbox)  (Widgets) - returns pages that contain the term sandbox but not the term widgets..NOT

The search operators have to be written in uppercase letters.

Elements

Hit count - shows how many matches a search has returned. It may be exact or approximate. 
Approximation is due to dynamic check for permissions to view each page in the results, some results 
may not be shown to the user with no adequeate permissions event if it matches the search term.
Tools - these are located in the top right as a set of buttons:

Create a page - represented by a "plus" button - will create a page with current search term as a 
title (only visible if user has permission to create pages)
Add filters - represented by a "funnel" icon - opens a dialog where users can select the type of filter 
to apply to the search.

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch2.png
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Adding filters

Search options - represented by a "gear" icon - opens a dialog where users can change settings for 
the current search. It provides options like the number of results per page, sorting field and order.

Options dialog

Export search - represented by the "export" icon - opens a dialog to export current search results to 
a dedicated page (only visible to authorized users, by default admin users).

Filter: Filters are displayed in form of pills below the results counter. Each filter pill represents a 
different attribute. Filter values can be changed by clicking on the filter pill and selecting the desired 
options from the popup that will open. Filter can be removed by clicking on the "x" button in each pill.

https://bs3-en.wiki.bluespice.comhttps://en.wiki.bluespice.com/wiki/File:ExtendedSearch3.png
https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch5.png


Category:Search

26.03.2025 This document was created with BlueSpice Page  of 8 27

Editing filter

Results: If current search criteria yield any results, a list of results is displayed. The information 
available in the results is depending on the result type):

Main title of the result (page title, file name...)
Result type
Size and extension (for files)
Thumb image (for images) or file type icon (for other file types)
Redirect information
Original name (for wikipages, if the page display title is different than the actual page title)
Secondary information like page categories, modification and creation date, author, etc.
Snippet of the matches in the content of the page (if there are matches in the page content),
Sections with matches in the content (for wikipages)

In case there is an exact match for a given search term, the result that matches exactly is 
displayed as a "featured" result. Such a result displays a preview image of the page and always 
displays the content snippet, regardless of whether there are matches in the content or not.

Results relevance

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the 
right corner of each result. Files marked as "favorite" will score higher in future searches - this is 
not visible immediately, however, but happens over time. One user's relevance settings won't 
affect other user's searches. Results can be unmarked as "favorite" by clicking on the "star" 
symbol again.

Exporting search results

After executing the search, administrators can export (save) the results to a specific page using 
the "Export" command from the "Tools" menu. The list is exported to MediaWiki:PageCollection
/LISTENNAME.

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch4.png
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Only valid wikipages are exported. The pages contained in a list can be included in a book in the 
book function via Mass add> Source: Page collection.

Export search

Configuration

In the , under settings for the extension , the BlueSpiceConfigManager BlueSpiceExtendedSearch
following configuration options are available:

External file paths: External locations to scan for and index files from. These locations are entered in 
key/value pairs of Physical path and URL prefix.

Physical path: Storage path. For mounted drives, for example: X:\Documents
URL prefix: All files indexed from the indexed physical location are prefixed in the search results. It 
should be used if files are available from a web server. By default, the URL prefix is set to the same 
value as .Physical path

Examples for external file paths

Example file Phys. Path URL Prefix Link in results list

S:\Sales\Info\glossaryy.pdf S:\

file:///S:/ file:///S:/Sales/Info/glossary.pdf

https://sharepoint
/Sales/

documents/

https://sharepoint/Sales/

documents/Sales/Info/glossary.
pdf

https://intranet
/showdocs

inline.aspx?path=

https://intranet/showdocsinline.
aspx?

path=/Sales/Info/glossary.pdf

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch6.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager
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Example file Phys. Path URL Prefix Link in results list

/var/www/bluespice/w
/mounted_

share/Sales/Info/glossary.
pdf

/var/www/bluespice
/w/

mounted_share/

https://wiki.company.local/w
/mounted_

share/Sales/Info/glossary.pdf

Use simple autocomplete: forces a more compact autocomplete (1-column Sales thumbnail preview).

compact autocomplete

Salesautocompletey

Automatically set language filter: This setting applies to multi-languageSalesIt returns seyarch 
results for a user only in the user's language. Users can set their language in their .preferences
Exclude patterns: Files at external file locations can be exluded from search based on regular 
expression patterns.

SearchAdmin

Special:SearchAdmin is a special page for wiki admins. This page provides stats on documents 
indexed in the search.

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:configuration-autocomplete-simple.1575886540740.png
https://bs3-en.wiki.bluespice.com/wiki/File:Manual:configuration-autocomplete-regular.1575886496796.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Preferences
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Related info

Reference:BlueSpiceExtendedSearch

Interwiki search

A  of this page,  on , was based off this revision.quality version approved 28 July 2020
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InterwikiSearch alows simultaneously searching other BlueSpice wikis when performing a 
search on the wiki.

Usage

If BlueSpiceInterwikiSearch is enabled and configured on the wiki, every time user performs a 
search using the , results from other wikis will be shown as well. Results Special:SearchCenter
from other wikis will be shown at the top of the page, below the filters, in form of Wiki name 
(number of results) buttons.

Results button for another wiki

Viewing results from other wikis

Clicking on a particular wiki's button will open a dialog containg the first page of the results, in 
order to enable quick and easy way of visualizing the results. If the desired document is not listed 
on this page, user can redirect to the target wiki and perform a full search on that wiki, by 
clicking on "Open full search" button at the top right corner of the dialog. This will open the 

 on the target wiki, with current search term already inserted.Special:SearchCenter

https://bs3-en.wiki.bluespice.com/wiki/File:InterwikiSearch1a.png
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Results from another wiki

Related info

ExtendedSearch
Reference:BlueSpiceInterwikiSearch

Search field in the page content (TagSearch)

A  of this page,  on , was based off this revision.quality version approved 19 May 2021

 allows the integration of a configurable search field in content pages. This search TagSearch
field relies on .BlueSpiceExtendedSearch

Inserting the tag

The tag  can be inserted and configured directly in visual editing mode.<bs:tagsearch />

Go to  in the  menu. Select tagsearch from the dialog and click Insert > Magic word VisualEditor
done. This opens the configuration options dialog on the page.

https://bs3-en.wiki.bluespice.com/wiki/File:InterwikiSearch2.PNG
https://bs3-en.wiki.bluespice.com/wiki/Reference:BlueSpiceInterwikiSearch
https://bs3-en.wiki.bluespice.com/w/index.php?title=Manual:Extension/BlueSpiceTagSearch&stableid=25606
https://bs3-en.wiki.bluespice.com/w/index.php?title=Special:Log&type=review&page=Manual:Extension/BlueSpiceTagSearch
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/VisualEditor
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Inserting TagSearch on a page

Parameter
Display 

name
Description

placeholder Placeholder Text to be shown in the search field when nothing is typed in

type Type

List of types of search entities to search. By default search entities availble 
are: , ,  (internal files),  . wikipage specialpages repofile externalfile, socialentity
Multiple values can be entered separated by pipe (|) - "wikipage|repofile"

Note: If a particular namespace is selected, then type "repofile" 
returns uploaded files that have the associated namespace prefix.

namespace
Namespace
(s)

List of namespaces in which to search. Namespaces can be entered by using 
their IDs or names, separated by a pipe (|). IDs and names cannot be mixed. 
Correct entries are: "1|6|8", "Help|QM", while invalid is "1|QM".

To search in the main namespace, use an empty space as value (e.g., " 
" or " |Template")

category
Category(-
ies)

List of categories in which to search. Mutltiple categories must be separated by 
a pipe (|) - "Cat1|Cat2"

Applies only to categories. Operator "AND" will only find results that are in all 
of the given categories, while operator "OR" will show results in any of the 

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:Mediawiki_Extension_TagSearch.png
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Parameter
Display 

name
Description

operator Search 
operator

given categories.

Multiple tags can be added to a single page using the same or different configurations.

Using the search field

Once the page is saved, the code for the search field is inserted in the page source where it was 
inserted.

Example:

<bs:tagsearch type="wikipage" operator="AND" namespace=" |Template" category="Editing" 
/>

The search is looking for wiki pages in the namespaces  and  that belong to the (Main) Template
category .Editing

Clicking on search icon to the left or pressing  loads the full-text search in the Return Search-
. Center

Search field on the page

Related info

Reference:BlueSpiceTagSearch

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:magicword-tagsearch-output.png
https://bs3-en.wiki.bluespice.com/wiki/Reference:BlueSpiceTagSearch
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10 Extended search

 replaces the default MediaWiki search engine. It is based on the  ExtendedSearch Elasticsearch
engine and provides many improvements over standard MediaWiki search both in terms of 
quality of indexed content and user interface. Pages and files are indexed immediately and 
available for searching in real-time.
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1.  
2.  

Usage

Extended search offers two ways of searching for content:

Title search using the quick search
Fulltext search using the search center

By default, the search indexes:

wiki pages: all content pages, except for pages in the MediaWiki namespace
special pages: all pages in the namespace Special
repo files: files uploaded to the wiki - for text files like Word documents and PDFs, this includes content 
and metadata
external files: files from arbitrary locations from accessible storage paths (e.g., mounted drives)
social entities: entities (pages) created by the  extension, like blog posts and user profilesBlueSpiceSocial

Autocomplete

The search box in the main toolbar offers with autocomplete functionality is available from any 
page on the wiki. Autocomplete matches only page and file titles, but does not provide a full-text 
serach.

After typing in the search bar, an autocomplete popup appears:

Autocomplete popup

This popup is divided in two columns.

Left column:

Primary results: These are the results that are direct matches for the search term. The exact matches 
are shown in bold letters.

When looking for the term "quality management", it is also possible to type in "qual man" and the 

https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceSocial
https://bs3-en.wiki.bluespice.com/wiki/File:Manual:extendedsearch-autocompleteEN.png
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When looking for the term "quality management", it is also possible to type in "qual man" and the 
search starts looking for matches
The best match is often shown with a thumbnail preview as a top search result

Right column:

T  Tools are displayed in the top portion of the right column and contain:ools and secondary results:
a button to create the page with the current search term as the title (only if user has permission to 
create new pages)
a button to execute full-text search for the current term. Selecting this option leads to the Search 
Center.

In the bottom portion of the right column, secondary results are displayed. Secondary results are 
matches that do not directly match the given term, but might be relevant for the user. These 
show up only in certain contexts:

If there are significantly more matches for a similar term than the term actually searched for (in a 
situation of a typo for example)
If the namespace or subpage pill is present (see next section). In this case, secondary results will show 
direct matches in other namespaces/pages.

Namespace and subpage "pills"

Autocomplete search bar supports pills for namespaces and subpages.

Namespace "pill"

If a user types , a pill for the namespace "Manual" appears and the search for the Manual:
following term is limited to this namespace. . Subpage pills work in the same way. If the user 
types in , any term after that is matched in the context of that page. If you search for PageName/
"TestPage/Te", for example, the search will match only subpages of "TestPage" that contain "Te" 
in the title, like "TestPage/Test" and "TestPage/TestSubpage".

Configuration

Previously explained is the full version of the autocomplete popup. Wiki admins can also choose 
to use "Simple autocomplete", which contains only one column with primary results and tools, 
without secondary results. This type of autocomplete is also more compact. This setting is 
available from , under BlueSpiceConfigManager Extension > BlueSpiceExtendedSearch > Use 

.simple autocomplete

Search operators

Since the autocomplete search only searches for titles, search operators such as AND or OR are 
not supported. However, they are supported using the Search Center.

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:extendedsearch-pilleEN.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager
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Dates as search terms

The search recognizes certain date formats. In the search center, these date formats are treated 
with surrounding quotation marks.

 

Date format 1

Date format 2

Search Center (extended search)

As soon as you trigger the full-search with the magnifying glass symbol or the  key, the wiki Enter
switches to the Search Center. This is a special page that offers the full functionality of the 
search. The search in the Search Center is carried out using the same search bar that is also used 
for autocomplete.

Here, the search engine carries out a full text search, which also includes the metadata of 
documents. It does not index the wikitext of a wiki page, but rather the rendered content, that is 
the output by the browser.

https://bs3-en.wiki.bluespice.com/wiki/File:extendedsearch-datum1.png
https://bs3-en.wiki.bluespice.com/wiki/File:extendedsearch-datum2.png
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Search Center

Search operators

To use search operators in the full-text search, the following syntax can be used:

Sandbox  Widgets - returns pages that contain both the term sandbox and the term widgetsAND
Sandbox  Widgets - returns pages that contain either the term sandbox or the term widgets.OR
(Sandbox)  (Widgets) - returns pages that contain the term sandbox but not the term widgets..NOT

The search operators have to be written in uppercase letters.

Elements

Hit count - shows how many matches a search has returned. It may be exact or approximate. 
Approximation is due to dynamic check for permissions to view each page in the results, some results 
may not be shown to the user with no adequeate permissions event if it matches the search term.
Tools - these are located in the top right as a set of buttons:

Create a page - represented by a "plus" button - will create a page with current search term as a 
title (only visible if user has permission to create pages)
Add filters - represented by a "funnel" icon - opens a dialog where users can select the type of filter 
to apply to the search.

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch2.png


Category:Search

26.03.2025 This document was created with BlueSpice Page  of 21 27

Adding filters

Search options - represented by a "gear" icon - opens a dialog where users can change settings for 
the current search. It provides options like the number of results per page, sorting field and order.

Options dialog

Export search - represented by the "export" icon - opens a dialog to export current search results to 
a dedicated page (only visible to authorized users, by default admin users).

Filter: Filters are displayed in form of pills below the results counter. Each filter pill represents a 
different attribute. Filter values can be changed by clicking on the filter pill and selecting the desired 
options from the popup that will open. Filter can be removed by clicking on the "x" button in each pill.

https://bs3-en.wiki.bluespice.comhttps://en.wiki.bluespice.com/wiki/File:ExtendedSearch3.png
https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch5.png
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Editing filter

Results: If current search criteria yield any results, a list of results is displayed. The information 
available in the results is depending on the result type):

Main title of the result (page title, file name...)
Result type
Size and extension (for files)
Thumb image (for images) or file type icon (for other file types)
Redirect information
Original name (for wikipages, if the page display title is different than the actual page title)
Secondary information like page categories, modification and creation date, author, etc.
Snippet of the matches in the content of the page (if there are matches in the page content),
Sections with matches in the content (for wikipages)

In case there is an exact match for a given search term, the result that matches exactly is 
displayed as a "featured" result. Such a result displays a preview image of the page and always 
displays the content snippet, regardless of whether there are matches in the content or not.

Results relevance

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the 
right corner of each result. Files marked as "favorite" will score higher in future searches - this is 
not visible immediately, however, but happens over time. One user's relevance settings won't 
affect other user's searches. Results can be unmarked as "favorite" by clicking on the "star" 
symbol again.

Exporting search results

After executing the search, administrators can export (save) the results to a specific page using 
the "Export" command from the "Tools" menu. The list is exported to MediaWiki:PageCollection
/LISTENNAME.

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch4.png
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Only valid wikipages are exported. The pages contained in a list can be included in a book in the 
book function via Mass add> Source: Page collection.

Export search

Configuration

In the , under settings for the extension , the BlueSpiceConfigManager BlueSpiceExtendedSearch
following configuration options are available:

External file paths: External locations to scan for and index files from. These locations are entered in 
key/value pairs of Physical path and URL prefix.

Physical path: Storage path. For mounted drives, for example: X:\Documents
URL prefix: All files indexed from the indexed physical location are prefixed in the search results. It 
should be used if files are available from a web server. By default, the URL prefix is set to the same 
value as .Physical path

Examples for external file paths

Example file Phys. Path URL Prefix Link in results list

S:\Sales\Info\glossaryy.pdf S:\

file:///S:/ file:///S:/Sales/Info/glossary.pdf

https://sharepoint
/Sales/

documents/

https://sharepoint/Sales/

documents/Sales/Info/glossary.
pdf

https://intranet
/showdocs

inline.aspx?path=

https://intranet/showdocsinline.
aspx?

path=/Sales/Info/glossary.pdf

https://bs3-en.wiki.bluespice.com/wiki/File:ExtendedSearch6.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager
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Example file Phys. Path URL Prefix Link in results list

/var/www/bluespice/w
/mounted_

share/Sales/Info/glossary.
pdf

/var/www/bluespice
/w/

mounted_share/

https://wiki.company.local/w
/mounted_

share/Sales/Info/glossary.pdf

Use simple autocomplete: forces a more compact autocomplete (1-column Sales thumbnail preview).

compact autocomplete

Salesautocompletey

Automatically set language filter: This setting applies to multi-languageSalesIt returns seyarch 
results for a user only in the user's language. Users can set their language in their .preferences
Exclude patterns: Files at external file locations can be exluded from search based on regular 
expression patterns.

SearchAdmin

Special:SearchAdmin is a special page for wiki admins. This page provides stats on documents 
indexed in the search.

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:configuration-autocomplete-simple.1575886540740.png
https://bs3-en.wiki.bluespice.com/wiki/File:Manual:configuration-autocomplete-regular.1575886496796.png
https://bs3-en.wiki.bluespice.com/wiki/Manual:Preferences
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Related info

Reference:BlueSpiceExtendedSearch

10.2 Search field in the page content (TagSearch)

 allows the integration of a configurable search field in content pages. This search TagSearch
field relies on .BlueSpiceExtendedSearch

Inserting the tag

The tag  can be inserted and configured directly in visual editing mode.<bs:tagsearch />

Go to  in the  menu. Select tagsearch from the dialog and click Insert > Magic word VisualEditor
done. This opens the configuration options dialog on the page.

Inserting TagSearch on a page

https://bs3-en.wiki.bluespice.com/wiki/Reference:BlueSpiceExtendedSearch
https://bs3-en.wiki.bluespice.com/wiki/Manual:Extension/VisualEditor
https://bs3-en.wiki.bluespice.com/wiki/File:Manual:Mediawiki_Extension_TagSearch.png
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Parameter
Display 

name
Description

placeholder Placeholder Text to be shown in the search field when nothing is typed in

type Type

List of types of search entities to search. By default search entities availble 
are: , ,  (internal files),  . wikipage specialpages repofile externalfile, socialentity
Multiple values can be entered separated by pipe (|) - "wikipage|repofile"

Note: If a particular namespace is selected, then type "repofile" 
returns uploaded files that have the associated namespace prefix.

namespace
Namespace
(s)

List of namespaces in which to search. Namespaces can be entered by using 
their IDs or names, separated by a pipe (|). IDs and names cannot be mixed. 
Correct entries are: "1|6|8", "Help|QM", while invalid is "1|QM".

To search in the main namespace, use an empty space as value (e.g., " 
" or " |Template")

category
Category(-
ies)

List of categories in which to search. Mutltiple categories must be separated by 
a pipe (|) - "Cat1|Cat2"

operator
Search 
operator

Applies only to categories. Operator "AND" will only find results that are in all 
of the given categories, while operator "OR" will show results in any of the 
given categories.

Multiple tags can be added to a single page using the same or different configurations.

Using the search field

Once the page is saved, the code for the search field is inserted in the page source where it was 
inserted.

Example:

<bs:tagsearch type="wikipage" operator="AND" namespace=" |Template" category="Editing" 
/>

The search is looking for wiki pages in the namespaces  and  that belong to the (Main) Template
category .Editing

Clicking on search icon to the left or pressing  loads the full-text search in the Return Search-
. Center
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Search field on the page

Related info

Reference:BlueSpiceTagSearch

https://bs3-en.wiki.bluespice.com/wiki/File:Manual:magicword-tagsearch-output.png
https://bs3-en.wiki.bluespice.com/wiki/Reference:BlueSpiceTagSearch
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